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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version.  

• Publish date, which changes each time the document is updated.  

Important Note: The initial version of this document is included in the patch package that is shipped with 
the patch release.  However, this document may undergo modifications after the patch is released.  To check 
for recent updates or to verify that you are using the most recent edition, visit the following URL: 
http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following web site:  
http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
http://www.adobe.com/
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In This Version 

Service Manager Version 9.21, build 551, Patch 6 (SM 9.21p6) includes several major updates as describe in 
this section. For information about the enhancements, fixes, and  
known issues included in this release, refer to the corresponding sections in this document. 
 
The following provides a summary of major updates included in this release: 

• Compatibility Matrix Updates 
• New Parameters 
• New JavaScript Methods 
• Upgrade of the Embedded Tomcat in the Server 
• Upgrade to LW-SSO v2.5 (Server and Web Tier) 
• DLL Files Updated for the ODBC Driver 

Compatibility Matrix Updates 

The following lists the compatibility matrix updates for Service Manger 9.21 in this release. 

• IBM WebSphere 8.0 Support 
• JBoss 5.1 Support 
• Tomcat  
• Internet Explorer 9 Support 
• Firefox 10 and 15 Support 

 

Note:  For more information, see the compatibility matrix for Service Manager 9.21 on the Software Support 
Online (SSO) site (http://support.openview.hp.com/sc/support_matricies.jsp). 

IBM WebSphere 8.0 Support 

IBM WebSphere version 8.0 has been certified on the web tier in this release.  

For the detailed steps of deploying HP Service Manager Web  tier on IBM WebSphere 8.0, see section Deploy 
the Service Manager Web Tier on WebSphere 8.0. 

JBoss 5.1 Support 

JBoss Enterprise Application Platform 5.1 has been certified on the Web tier in this release. JBoss 
Application Server 4.2 is no longer supported since this release. 

For the detailed steps of deploying HP Service Manager Web tier on JBoss 5.1, see section Deploy the 
Service Manager Web Tier on JBoss 5.1. 

Tomcat Support 

Tomcat 5.5 is no longer supported since 9.21p6 as it has reached its end of life as of September, 2012. 
Tomcat 6.0 remains certified and supported. 

Internet Explorer 9 Support 

The Service Manager Web client now supports Internet Explorer 9.  

http://support.openview.hp.com/sc/support_matricies.jsp
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Firefox 10 and 15 Support 

The Service Manager Web client now supports Firefox 10 and 15 since this release while Firefox 3.x is no 
longer supported. 

New Parameters 

The following list shows the new or updated parameters in this patch release.  

Server parameters 

• ldapnosizelimitmsg 

• fetchnotnullsystemp 

• disableWSEss 

• reportLBInterval 

• usedmemcompmode 

• cache_slots (updated) 

• maxgroupsperview 

• grouptimeout 

• maxhttpreqresponse 

• jsaccessfilereadregex and jsaccessfilewriteregex 

Web client parameters 

• acceptBrowserLang 

• maskMessageDelay 

 

ldapnosizelimitmsg 

Description  
When limiting LDAP query with ldapmaxrecords:100 (for example), if LDAP query results are bigger 
than 100 records, users get the following message: Message from LDAP server: Size limit 
exceeded. This informational message may mislead users to think that something is not working 
correctly. 
 

This parameter, when set to 1, disables this informational message so that it will not display to and 
therefore not disturb end users. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
No 

Default value:  
0 

Possible values: 
0 (Enable the informational message) 
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1 (Disable the informational message) 

Example usage: 
Command line: sm -httpPort:13080 -ldapserver1:ldapparent -ldapnosizelimitmsg:1  

Initialization file: ldapnosizelimitmsg:1 

See QCCR1E31999. 

fetchnotnullsystemp 

Description  
Records that have a non-NULL systemplate field will merge the template record before they are 
passed to the query condition filter. In the old versions, these records were passed to the query filter 
before they merged the template and were thus incorrectly filtered out. 
 
This parameter specifies whether or not to fully enable the template merge functionality. You need 
to set it to "fetchnotnullsystemp:1" to fully enable the template merge functionality. However, it may 
cause performance issues if the table has more than 10K records whose systemplate field is not 
NULL. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
No 

Default value:  
0 

Possible values: 
0 (Do not fully enable the template merge functionality) 
1 (Fully enable the template merge functionality) 

Example usage: 
Command line Command line: sm - fetchnotnullsystemp:1 

Initialization file: fetchnotnullsystemp:1 

See QCCR1E32145. 

disableWSEss 

Description  
This parameter controls whether or not a non-ESS user consumes a floating or named license when 
logging in to Service Manager through Service Request Catalog: 

• By default, a non-ESS user consumes only a self-service (unlimited) license instead of a floating 
or named license;  

• If this parameter is set in sm.ini or the server's OS command prompt (no value needed), a non-
ESS user then consumes a floating or named license. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
No 
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Default value:  
 (When this parameter is not present) A non-ESS user consumes only a self-service license instead of 
a floating or named license. 

Possible values: 
None 

Example usage: 
Command line Command line: sm -httpPort:13080 -httpsPort:13081 -disableWSEss 

Initialization file: disableWSEss 

See QCCR1E71017. 

reportLBInterval  

Description  

This parameter defines the interval (in seconds) at which Service Manager automatically runs the 
load balancer status report, which includes information about available ports and threads in 
horizontal and vertical scaling servlet implementations. When this parameter (reportLBInterval:n) 
is specified, Service Manager automatically executes the reportlbstatus command every n seconds to 
write the load balancer status information to the following log file located in the same directory of 
the server log (sm.log): lbstatus_<pid>.log, where <pid> is the ID of the load balancer process.  

By default, this parameter is disabled; if a value less than 60 is specified for n, it is automatically 
reset to 60.  

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 
Startup file (sm.cfg) 

Requires restart of HP Service Manager server?  
Yes 

Default value:  
0 (Disabled) 

Possible values: 
  0 (Disabled by defult) 

Numbers no less than 60 (If a value less than 60 is specified, it is automatically reset to 60.) 

Example usage: 
Command line Command line: sm -httpPort:13080 -loadbalancer -reportLBInterval:180 

Initialization file (sm.ini): reportLBInterval:180 

Startup file (sm.cfg): sm -httpPort:13080 -loadbalancer -reportLBInterval:180 

See QCCR1E71722. 

usedmemcompmode  

Description  

This parameter determines the calculation method for how memory usage is calculated.  

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 
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Requires restart of HP Service Manager server?  
Yes 

Default value:  
0 (The default is 0, which is the normal Service Manager method) 

Possible values: 
  0 (Specifies that used memory will be the sum of committed memory plus the reserved memory)  
  1 (Specifies that used memory will be equal to the committed memory, but no loge entry)  
  2 (Specifies that used memory will be equal to the committed memory but with a log entry)  
Example usage: 

Command line: sm -httpPort:13080 – usedmemcompmode:0  

Initialization file: usedmemcompmode:1  

(This will sum only the committed memory when computing the used memory, and will not generate 
a line of calculation log in sm.log.)  

See QCCR1E71853. 

cache_slots (updated) 

The default value of this parameter has been changed from 2003 (which is too low) to 9973 to improve 
system performance. For more information, see QCCR1E71918.  

For detailed information about this parameter, see the Service Manager help. 

maxgroupsperview 

Description  

This parameter defines the maximum number of groups that can be used in a view. When a user 
selects a view from the View list whose group count exceeds the limit, only the maximum allowed 
number of groups can be displayed in the view, and the following message displays in the client UI:  

"Maximum number of groups (xxxx) exceeded. Please modify the view definition to reduce the 
number of groups."   

Note: This limit would be useful if a user runs a poorly created view that causes the servlets to 
consume too much CPU and memory and terminate the servlets. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
Yes 

Default value:  
5000 (groups) 

Possible values: 
 500 or greater (if a value less than 500 is specified, Service Manager will ignore the value and use 

500 instead. A warning message will also occur in the sm.log file: "A maxgroupsperview value less 
than 500 specified and ignored. 500 is used.")  

Example usage: 
Command line: sm -httpPort:13080 -maxgroupsperview:6000 
Initialization file: maxgroupsperview:6000 
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See QCCR1E72836. 

grouptimeout 

Description  

This parameter allows you to configure the timeout value (in milliseconds) for Jgroups remote 
procedure calls. You can tune this value to keep the number of available nodes stable. 

It is recommended to set this parameter to a minimal value as long as it can keep the number of the 
available nodes stable. Meanwhile, the network latency between the web server and the HP Service 
Manager server should be small, otherwise the load balancer may forward a request to a node that is 
not able to handle the request due to network latency. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
Yes 

Default value:  
1000 (milliseconds) 

Possible values: 
 Any number of milliseconds from 300 to 10000 

Example usage: 
Command line: sm -grouptimeout:1500 
Initialization file: grouptimeout:1500 

See QCCR1E75022. 

 

maxhttpreqresponse 

Description  
This startup parameter defines the maximum response size (in bytes) for HTTP requests.  

Note: A zero value disables the feature, which means there is no size limit. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
Yes 

Default value:  
20971520 (20MB) 

Possible values: 
0: No size limit 
Any size limit (in bytes) 
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jsaccessfilereadregex and jsaccessfilewriteregex 

Description  

These parameters specify access restrictions from JavaScript code for file access. This is required for 
security reasons so that the system can prevent users from using to use the available Service 
Manager JavaScript APIs to directly access the underlying host file system in an unauthorized way. 
These restrictions are described below: 

• System administrator (sysadmin) users are allowed unrestricted access to the file system. 
• Non-sysadmin users are allowed unrestricted access as well by default (none of these 

configuration parameters is present); if any of these parameters is present, access is restricted as 
follows: 

- jsaccessfilereadregex:<regex>: Files read using the readFile() and uncompressFile() 
(compressed file only) JavaScript functions must have an absolute path name that matches 
the regular expression <regex>. 

- jsaccessfilewriteregex:<regex>: Files written using the writeFile(), deleteFile(), makeDir(), 
uncompressFile() (output dir only), and writeAttachmentToFile() JavaScript functions must 
have an absolute path name that matches the regular expression <regex>. 

Regular expressions must use proper syntax for Java-style regex (similar to Perl-style) (for example, 
'.' means any character and backslashes need to be doubled). File path names in 
jsaccessfilereadregex and jsaccessfilewriteregex must be absolute and use proper delimiters ('/' for 
UNIX, and '\' for Windows). They are case-sensitive for UNIX and case-insensitive for Windows. 

File path names used as parameters to JavaScript functions can still be any legal OS-specific file 
path names. Absolute and relative path names are allowed as well as the usage of '.' and '..'. On 
Windows, delimiters can be either '/' or '\', while UNIX only allows '/'. However, path names from 
JavaScript commands are normalized first (relative paths are made absolute, the '.' and '..' are 
eliminated, and on Windows '/'s are transformed into '\'s) before they are pattern matched against 
their corresponding regular expression. 

Valid if set from:  
Server's OS command prompt 
Initialization file (sm.ini) 

Requires restart of HP Service Manager server?  
Yes 

Default value:  
  None (Unrestricted file access) 

Possible values: 
 Regular expressions 

Example usage: 

• jsaccessfilereadregex:C:\\Users\\joe\\Documents\\.+|C:\\SM-Install\\server-
dist\\RUN\\(\w)+\.js 

Read access is limited to any files under the C:\Users\joe\Documents directory and only for .js 
files under the C:\SM-Install\server-dist\RUN directory. 

• jsaccessfilewriteregex:^$ 

Only matches the empty string. This is used to deny all write access to the file system. 
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acceptBrowserLang 

Description  

The acceptBrowserLanguage parameter specifies the preference for the TSO language settings if 
the"lang" parameter is not set in the URL. By default, the browser language preference has higher 
priority than the language defined in the operator's profile. If you want the operator's profile 
language setting to take precedence over the browser language profile when the "lang" parameter is 
not set in the URL in a TSO environment, set this value to false. 

Note: If the "lang" parameter is set in the URL, it will take precedence over the acceptBrowserLang 
parameter. 

Valid if set from:  
  Web tier configuration file (web.xml) 

Requires restart of Web application server?  
Yes 

Default value:  
true 

Possible values: 
  false: Specifies that the operator’s profile language setting takes precedence. 

 true: Specifies that the browsers language setting takes precedence. 

Example usage: 
<init-param>  

<param-name>acceptBrowserLang</param-name>  
<param-value>true</param-value>  

</init-param>  

See QCCR1E73982. 

 

maskMessageDelay 

Description  
The maskMessageDelay specifies the number of seconds before the mask message is displayed after 
the mask is shown. The minimum value is 1 second and the maximum is 30 seconds. A default value 
of 5 seconds will be used if any invalid value specified. 

Valid if set from:  
  Web tier configuration file (web.xml) 

Requires restart of Web application server?  
Yes 

Default value:  
  5 seconds 

Possible values: 
Any integer value from 1 second to 30 seconds. Any invalid value will use the default value (5 seconds). 

Example usage: 
<context-param>  

<param-name>maskMessageDelay</param-name>  
<param-value>5</param-value>  

</context-param>  

See QCCR1E77454. 
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New JavaScript Methods 

The following JavaScript methods have been introduced in this release. 

• SCFile.getBinary() 

• SCFile.setBinary() 

SCFile.getBinary() 

This JavaScript method returns the binary representation of a field in a Service Manager file object. 
 

Syntax 

SCFile.getBinary (fieldName); 

Arguments 

Argument Data type Description 

fieldName String This argument specifies the name of a field from which 
you want to extract the binary data. 

Return values 

The method returns a JS object that contains the binary data of the field. 

Example 
var bb = new SCFile("bbtosysattachments"); 

var rc = bb.doSelect("true"); 

var attachmentObj= new Attachment(); 
attachmentObj.value = bb.getBinary("att_attachment") 
attachmentObj.name = bb.att_filename; 

attachmentObj.type = "excel"; 

See QCCR1E76875. 

SCFile.setBinary() 

This method saves the binary data to a field in a Service Manager file object. 
 

Syntax 

SCFile.setBinary (fieldName, binaryObj); 

 

Arguments 

Argument Data type Description 

fieldName String The name of a field in which you want to save the 
binary data. 

binaryObj String The name of a JS object that contains the binary data. 
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Return values 

RC_SUCCESS or one of the other global return code values. The method returns RC_SUCCESS if 
the method successfully saves binary data to a Service Manager file object or returns one of the error 
global return code values if the method cannot save binary data to a Service Manager file object. 

Example 
var rc; 

var f = new SCFile("contacts"); 

rc = f.doSelect('contact.name#"AARON"'); 

var attachmentObj = f.getAttachments(); 
var b = new SCFile("blob1"); 

b.name = attachmentObj[0].name; 
b.setBinary ("data",attachmentObj[0].value ); 
rc = b.doSave(); 

See QCCR1E79400. 

 

Upgrade of the Embedded Tomcat in the Server  

The Service Manager server now bundles Tomcat 6.0.35 as the embedded server. This upgrade requires 
additional steps for installing the server update in this release. See Server Installation. 

 

Upgrade to LW-SSO v2.5 (Web Tier) 

As of SM 9.21p6, the Service Manager Web tier has been upgraded to LW-SSO version 2.5. 

In the Web tier’s lwssofmconf.xml file, a new parameter, secureHTTPCookie, has been introduced. The 
default is "true". This parameter must be set in combination with the secureLogin parameter in the Web tier 
configuration file (web.xml) so that LW-SSO can work correctly: 

• If secureHTTPCookie is set to true, secureLogin must also be set to true;  

• If secureHTTPCookie is set to false, secureLogin can be set to true or false as needed (you are 
recommended to set both to true in a production environment).    

 

DLL Files Updated for the ODBC Driver 

Three .dll files (Scodbc32.dll, sci18n.dll and sccl32.dll) have been updated to allow 16 joined array tables at 
most (see QCCR1E67090). For instructions on installing the updated files, see ODBC Driver Update 
Installation. 



 13 

Enhancements 

This release includes the following enhancements. 

 

Global ID Module Problem  Solution  

QCCR1E67279 Web Client The Service Manager Web 
Client does not support 
Internet Explorer 9.  

The Web Client now works with 
Internet Explorer 9. 

QCCR1E70664 Web Client The current compatibility 
matrix of Service Manager does 
not include IBM WebSphere 
Application Server v8.0.   

IBM WebSphere Application Server 
v8.0 is now supported. 
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Fixes 

Service Manager Version 9.21, build 551 patch 6 (SM 9.21p6) includes customer requested software fixes. 
Refer to the sections below for information about the defects for each release included in this cumulative 
patch. 

Service Manager 9.21 patch 6 updates the following areas: 

• Server 

• Web Tie 

• Windows Client 

• Application 

• Documentation 

Server 

The following items are fixed in the current software release. 

Global ID Problem  Solution  

QCCR1E31999 Users are receiving a confusing error 
message when LDAP query results exceed 
the maximum size (100 records, for 
example). The message should be 
available only in the log file for debugging 
purposes, rather than displaying in the 
Service Manager client window. 

Added a new parameter 
(ldapnosizelimitmsg), which allows system 
administrators to disable the LDAP size 
limit message.  
See ldapnosizelimitmsg. 

QCCR1E32145 Search Results are inaccurate against the 
operator table if an operator's Template 
(systemplate) field has a value. The 
operator record will not display in a 
Search, even though the selection criteria 
says it should. 

Records that have a non-NULL systemplate 
field now will merge the template record 
before they are passed to the query condition 
filter. In the old versions, these records were 
passed to the query filter before they merged 
the template and were thus incorrectly 
filtered out. 
A new parameter (fetchnotnullsystemp) is 
introduced in sm.ini. You need to set it 
to "fetchnotnullsystemp:1" to fully enable 
the template merge functionality. However, 
it may cause performance issues if the table 
has more than 10K records whose 
systemplate field is not NULL. 
See fetchnotnullsystemp. 
 

Known issue:  When clicking on the Fill 
button, all operator records will be searched 
out. The issue was fixed by QCCR1E55519 
in 9.21.ap1. Apply the 9.21.ap1 patch or 
contact HP Support to obtain the hotfix to 
fix this issue. 
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Global ID Problem  Solution  

QCCR1E54248 When Service Manager processes a web 
service request and sends a response, the 
response is not understood by the 
requesting application. This behavior 
results in the following error message: 
"type" attribute in <cmn:messages> tag 
not matching Common.xsd schema 
definitions. 

A code change was implemented in 
Common.xsd, so that "StringType" is always 
used as the base type of "MessageType." 

QCCR1E56867 Memory requirement for each thread on 
the server is high, as the XML response 
node is being duplicated. 

Eliminated the duplicate DOM object 
requirement. 

QCCR1E67090 When running reports that include more 
than 7 array tables with the 6.2.8 ODBC 
driver, Crystal Reports crashes. 

The ODBC driver now allows 16 joined 
array tables at most. 
See also ODBC Driver Update Installation. 

QCCR1E67562 Request for a way of turning off the 
"Triggers have been turned on" and 
"Triggers have been turned off" messages 
in the log file. 

Now, you can use the rtm parameter to turn 
the "Triggers have been turned on" and 
"Triggers have been turned off" messages on 
or off. 
To turn messages on, set the value of the 
rtm parameter equal or greater than 2. 

QCCR1E70418 Service Manager servlets report a 
potential memory leak. 

Memory is now released properly when it is 
finished being used. 

QCCR1E70833 A complex query that uses a condition for 
an array field returns no record data. 

The complex query will display results as 
expected. 

QCCR1E71017 When a non-Employee Self-Service (non-
ESS) user logs in to Service Request 
Catalog (SRC), the user consumes a 
floating or named license, instead of a self-
service (unlimited) license. Additionally, 
one user consumes more than one floating 
license if the user is logged in to both SRC 
and Service Manager at the same time. 

A new parameter, disableWSEss, has been 
introduced to solve this problem.  
 
See disableWSEss.  

QCCR1E71099 Users need to display Value Lists instead 
of the data directly retrieved from the 
database in a QBE list when adding a field 
by using Modify Columns. 

Value Lists can be displayed instead of the 
data directly retrieved from the database in 
a QBE list when adding a field by using 
Modify Columns. To achieve this, it requires 
both the current patch release and the 
corresponding unload file. 
For the unload file, see New Application 
Updates in the Current Patch. 

QCCR1E71722 The status of the load balancer is not 
reported periodically. 

Introduced a new parameter, 
reportLBInterval:n, which automatically 
reports the status of the load balancer every 
n seconds.  
 
See reportLBInterval. 
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Global ID Problem  Solution  

QCCR1E71853 The "NativeMemory" size never shrinks. To resolve this issue, the 
usedmemcompmode parameter has been 
added. This parameter determines how used 
memory is calculated according to the 
following: 
 
0:used=committed + reserved;  
1:used=committed,no log;  
2:used=committed,log.  
 
The default is 0, which is the old Service 
Manager method. 
See usedmemcompmode. 

QCCR1E71830 A potential memory leak may occur when 
Service Manager finds duplicate keys 
while performing a database operation. 

The memory leak has been resolved. 

QCCR1E71934 Licenses are not released when users log 
out from the system. The value output 
from the 'reportlic' parameter does not 
match the number of users on system 
status screen. As a consequence, the 
number of license slots run out and 
Service Manager has to be restarted to 
clear the issue. Licenses should be 
released when users log out from the 
system and 'reportlic' should match the 
number of users on system status screen. 

Now when users execute "sm -reportlic", 
Service Manager provides a mechanism to 
purge the zombie license users and release 
their licenses. 

QCCR1E71918 The default value of parameter 
cache_slots, currently set at 2003 is too 
low. It should be set to a larger value 
(approximately 10000). 

The default value of cache_slots is now set to 
9973.  

Note: If this parameter is not set or set to be 
greater than 100,000 or less than 300, the 
default value (9973) is used; if it is set to a 
non-prime number, the smaller one of its 
neighboring prime numbers is used instead. 
See cache_slots. 

QCCR1E71999 The Service Manager log contains lock-
failure messages: 
org.jgroups.blocks.LockNotReleasedEx
ception: Lock cannot be unlocked 
when session terminates. 

When a session ends, no unlock failure is 
reported. 

QCCR1E72171 When the system is forced to shutdown, 
the USERINFO table cannot be cleared. If 
you run the sm -reportlic when the system 
is restarted and before any users log in, it 
will report the licenses consumed by the 
previous sessions. This will lead to a bad 
license accounting and prevent users 
logging into the system. 

The USERINFO table will be cleared as 
expected.  

Note: After applying the fix, system 
administrators need to run the "sm -
unlockdatabase" command to clean up the 
license tables. 
See also Server_installation. 
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Global ID Problem  Solution  

QCCR1E72566 Service Manager performance on the AIX 
platform is significantly worse than other 
platforms when multiple users are 
executing workflows that make heavy use 
of Javascript. 

Optimized JavaScript execution in SM for 
AIX so that property names are only 
retrieved as needed. 

QCCR1E72743 The Web client ignores the "Invisible" 
settings in the fields of the "Data policy" 
table. 

The Web client no longer ignores the 
"Invisible" settings in the fields of the "Data 
policy" table.  

QCCR1E72836 There is no limit on the number of records 
an SM Process can try to fetch. A limit 
would be useful if a user runs a poorly 
created view that causes servlets to 
consume too much CPU and memory and 
terminates the servlets. 

Added a parameter maxgroupsperview to 
limit the number of groups allowed in a 
view.  
See maxgroupsperview. 

QCCR1E72843 An attempt to add a field to the 
probsummary table in dbdict fails with a 
"Signal 11" error. 

This issue occurred because of a null pointer 
that causes the "Signal 11" error. This issue 
is resolved by verifying that a pointer is not 
null. 

QCCR1E72977 An XML Error is received when a solution 
field that contains special characters is 
updated in an SM Incident that was 
created by OMi. 

Service Manager can now send special 
characters to OMi by using valid encoding. 

QCCR1E72908 Shared Memory Initialization of Service 
Manager process is very slow, potentially 
taking over 30 seconds. 

Optimized the Service Manager process 
startup procedure to only load the data in 
SCAccess and SCFolderAccess files on 
demand. 

QCCR1E73151 When a session fails while holding a lock, 
the sync process should remove the lock. 
However, if the system is horizontally 
scaled, the process fails and the lock is not 
released. This behavior prevents any other 
session from accessing the locked resource. 

All locks for a currently exiting thread are 
now removed correctly. 

QCCR1E73406 A memory leak that is caused by 
GZIPInputStream makes the system 
unresponsive. 

The resource is now closed properly. 

QCCR1E73384 During the normal operation of the HP 
Operations Orchestration integration with 
Service Manager, the Service Manager 
server refuses Web service connections 
and issues the following warnings: 
"Server low on memory." 

This issue is caused by a memory leak. To 
solve this issue, a close() method is now 
called on the Page reference of the Lexer 
html parser to release the memory. 
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QCCR1E73543 Bound variables in Oracle SQL statements 
cause significant performance issues when 
combined with Mandanten security 
restrictions. This issue is compounded by 
Mandanten because the Mandanten 
restrictions are duplicated in the SQL 
statements. This behavior results in 
additional bound variables. 

Now, the Mandanten query restriction is 
appended only once. 

QCCR1E73864 The server process consumes a lot of 
memory and time when the "Go to last 
page" button is clicked from the Web client 
on the list/detail screen of a query with 
thousands of returned records. This 
behavior may occur because of a poorly 
created view. This behavior can cause the 
servlets to consume too much CPU and 
memory and eventually terminate the 
servlets. 

The server process now only lasts for a few 
seconds with less memory consumed when 
the "Go to last page" button is clicked on the 
list/detail screen of a query with thousands 
of returned records. This behavior will no 
longer terminate the servlets. 

QCCR1E73982 When trusted sign-on is enabled, the Web 
client uses the language specified in the 
operator record, instead of "lang" 
parameter passed in by the Ess.do url. 

For Web client, in WEB-INF/web.xml, a new 
servlet parameter, acceptBrowserLang, was 
added. 
 
By default, this value is true. If this value is 
true, the Web client will take the browser's 
language setting as the first priority in TSO 
mode. If the value is set to false, the Web 
client will use the language setting in the 
operator's profile. 
 
Note: If the "lang" parameter is set in the 
URL, it will take precedence over the 
acceptBrowserLang parameter. 
 
See acceptBrowserLang. 

QCCR1E74051 After applying a custom upgrade, users 
are experiencing sudden session timeouts 
in the Web tier and "Signal 11" errors in 
the Windows client. Investigation 
indicates that the "Signal 11" error is 
caused by a call to the 
RCCondition.isCalendarShow function 
when the Document Engine calls the 
probsummary master format control. 

The "Signal 11" error will not be thrown and 
will therefore prevent the user session from 
suddenly terminating.  
 
Note: This behavior (the "Signal 11" error 
NOT being thrown) occurs even if the 
memory for JavaScript is not sufficient to 
run the JavaScript program. This fix does 
not address the lack of memory. 

QCCR1E74101 Users cannot log in after starting a 
servlet, and the following message is 
logged: 
 
RTE E EVP_PBE_CipherInit() failed in 
desEncryptPasswordFieldWithMD5AndDes
() 

This issue occurred because of a concurrent 
call to the OpenSSL crypto library. This has 
been resolved so that the call will no longer 
impact the log in to Service Manager. 
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QCCR1E74441 The xmlFill.getValue() ScriptLibrary 
function fails with a "Signal 11" error if it 
is called with malformed XML or with no 
XML at all. 

The null pointer is now checked before this 
function is called. 

QCCR1E74646 Background event processes consume high 
memory usage, even though there are no 
event records to process. 

Background event processes can run 
without consuming excessive memory. 

QCCR1E74707 After setting the debugjavascript trace 
parameter to a value of 2 or 3, a "Signal 
11" error is received when attempting to 
log into the SM server. 

When debugjavascript is set to 2, the "Signal 
11" error will not occur. 

QCCR1E74709 Webservice requests get corrupted when 
they contain inline attachments whose 
base64 encoding contains carriage return 
line feeds. 

An RTE change is made to prevent inline 
attachments containing carriage return line 
feed characters from being corrupted. 

QCCR1E74742 SLA processes are terminating multiple 
times a day, resulting in core dumps. 

The unexpected terminations and core 
dumps have been eliminated. 

QCCR1E75022 There is a dedicated thread in the 
software loadBalancer that periodically 
requests the RTE Server to update the 
nodes information. However, the timeout 
value for this thread appears to be too 
small, which prevents the node 
information from being updated correctly. 
As a result, the number of available nodes 
fluctuates wildly. 

To resolve this issue, the new 
"grouptimeout" parameter has been 
introduced in sm.ini. This parameter allows 
you to configure the timeout value (in 
milliseconds) for Jgroups remote procedure 
calls. You can tune this value to keep the 
number of available nodes stable. Default is 
1000, minimum is 300, and maximum is 
10000.  
 
It is recommended to set this parameter to a 
minimal value as long as it can keep the 
number of the available nodes stable. 
Meanwhile, the network latency between 
the web server and the SM server should be 
small; otherwise the loadblancer may 
forward a request to a node that is not able 
to handle the request due to network 
latency. 
See grouptimeout. 

QCCR1E75564 Use of the rtm:3 parameter will cause a 
memory leak in the JavaScript engine on 
the SM server process. 

This issue was caused by the 
_getEndLineNum() function in the evjs.cpp 
file and resolved by changing the log 
message to skip logging the line number. 

QCCR1E75861 An array of structures nested within an 
array of structures in a dbdict table does 
not work in Oracle databases. 

An array of structures nested within an 
array of structures in a dbdict table works 
as expected in Oracle databases. 
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QCCR1E75975 In a vertically scaled system, one of the 
servlets hangs and a core file is generated 
on the production server.  
Every time a user logs in on the servlet, a 
"Signal 11" error is generated, and most 
times a core file as well. 

The defect that caused the "Signal 11" when 
connecting to an LDAP Server over SSL has 
been fixed. 

QCCR1E76056 Cannot search Change tickets with a 
Change ID. 

Now, tickets that have a Change ID can be 
searched as expected. 

QCCR1E76399 Partial System Outage occurs when a node 
in the cluster quit responding to requests. 
This behavior occurs when the 
Transparent Application Failover (TAF) 
feature on Oracle is enabled.  
 
When this issue occurs, the following 
messages are logged repeatedly:  
 
9568468(36438057) 05/06/2012 
13:50:37 RTE E Unable to parse date 
for column SYSMODTIME  
9568468(36438057) 05/06/2012 
13:50:37 RTE E Incomplete record, 
could not process data for table 
NUMBERM1 in file number identified 
by key: name="incidents"  
9568468(28049409) 05/06/2012 
13:50:37 RTE E Error in fetching 
sequence number for file incidents  
9568468(36438057) 05/06/2012 
13:50:37 RTE E date format '06-MAY-
12' unrecognized in sqlda 

Service Manager now detects the TAF 
configuration and prints warning messages 
to the sm.log at startup.  
 
The warning messages are listed below:  
 
  2852(  2844) 07/31/2012  
13:06:34  RTE   !!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!  
  2852(  2844) 07/31/2012  
13:06:34  RTE   ServiceCenter does not 
support Oracle TAF. Please remove TAF 
configuration  
and restart ServiceCenter to avoid 
running into outages.  
  2852(  2844) 07/31/2012  
13:06:34  RTE   !!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 

QCCR1E76660 Colon appears in the converted date when 
using the getTime() JavaScript function. 

This issue occurred because the current 
js_1.5rc6a.dll is built with Microsoft Visual 
Studio 2003 and there is a defect within the 
function for converting a double to a string. 
This issue was resolved by rebuilding the 
DLL with Microsoft Visual Studio 2008. 

QCCR1E76875 JavaScript does not properly handle 
binary data. 

Added a new JS method, getBinary, to 
retrieve the binary representation of a field. 
Following is an example of using this JS 
function:  
var bb = new 
SCFile("bbtosysattachments");  
var rc = bb.doSelect("true");  
var attachmentObj= new Attachment();  
attachmentObj.value = 
bb.getBinary("att_attachment")  
attachmentObj.name = bb.att_filename;  
attachmentObj.type = "excel"; 
See SCFile.getBinary(). 
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QCCR1E77101 Investigate if any improvements can be 
made in the timing of the following 
messages, to avoid unnecessary actions by 
the end user:  
 
"Server running low on memory, close 
some application tabs and try again"  
 
"Server running low on memory, relogin to 
the system" 

When the low memory condition is detected, 
SM will call the JVM Garbage Collection to 
decrease Java memory usage. SM will not 
send a "low on memory" message unless the 
server is still low on java memory after 
garbage collection is called. 

QCCR1E77265 The following error is received when 
invoking the "Define views" button:  
 
Invalid syntax for query. Failed parsing 
(view.define,setup.display.1) 

The error is no longer received and the 
define views window appears as expected. 

QCCR1E77310 When you associate an IM to a PM, the 
following error message is received: 
"Target file variable two is not a relation 
(script.execute, save.mods)" 

The fix for this behavior introduces the 
following behaviors: 

• Application start-up parameter 
variables (i.e., "$INTO.*") are no 
longer overwritten by other 
applications (especially RAD triggers) 
started by the current application. 

• You no longer need to define a "$L.*" 
local variable to cache start-up 
parameters for later reuse. Now this 
will be done automatically. 

Note: There is no need to recompile any 
RAD application to apply this fix. 

QCCR1E77491 A Signal 11 error is received during the 
SMOO process. 

No Signal 11 error is received during the 
SMOO process. 

QCCR1E78016 Trying to start multiple SM processes with 
the same httpPort simultaneously results 
in memory leak. 

No memory leak will occur when trying to 
start multiple SM processes with the same 
httpPort simultaneously. 

QCCR1E78530 Executing a query that does not parse 
results in a small memory leak. 

This issue occurs because when the RAD 
parser fails to parse a query, the parser will 
process the query with escape chars, and 
then try to parse again. However, the 
first parse of query will not free the 
allocated String that contains the parsed 
result, which causes the memory leak to 
occur. 
 
The allocated string is now released, which 
eliminates the memory leak. 

QCCR1E78828 The BSM/SM integration using the CI 
Alert Retrieval Service fails to parse 
JSON data. 

This issue occurred when the JSON file 
length exceeded 32KB. The RTE code now 
works as expected when the JSON file 
length is larger than 32KB. 
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QCCR1E78958 System-generated queries that contains " 
OR (m1."NUMBER" IS NULL)" or similar 
a syntax are slow to respond on Oracle 11. 

To avoid this issue, system-generated 
queries will no longer contain " OR 
(m1."NUMBER" IS NULL)" or similar 
syntax. 

QCCR1E79293 When a session receives a Signal 11 error, 
the session hangs.  Additionally, you 
cannot terminate the session by using the 
"kill" command in system status. The 
session continues to consume CPU. 

When a session receives a Signal 11 error, 
the session will be terminated. 

QCCR1E79400 You cannot extract data from 
SYSATTACHMENTS and manipulate the 
binary data without corrupting the data. 

A new JS method, setBinary, has been 
introduced to save the binary data to a 
table. 
Sample: 
var rc; 

var f = new SCFile("contacts"); 

rc = f.doSelect('contact.name#"AARON"'); 

var attachmentObj = f.getAttachments(); 

var b = new SCFile("blob1"); 

b.name = attachmentObj[0].name; 

b.setBinary ("data",attachmentObj[0].value 
); 

rc = b.doSave(); 

See SCFile.setBinary(). 

QCCR1E79917 Libjs.so relies on the gcc library in the 
RTE/RUN folder on AIX 
platform.  Therefore, if the user 
environment does not have gcc installed, 
Service Manager cannot be started. 

Service Manager can be started even if the 
user does not have gcc installed. 
  

QCCR1E80243 A session terminates with a Signal 11 
error, and you cannot to terminate the 
session by using the "kill" command in 
system status.  Therefore, the session 
continues to consume CPU. 

By avoiding the unnecessary access when 
the JavaScript Garbage Collector finalizes 
an iterator, the Signal 11 error no longer 
occurs. 

QCCR1E84079 Errors occur when applying an application 
patch on a Service Manager production 
environment. 

No error occurs when applying an 
application patch on a Service Manager 
production environment. 

QCCR1E84106 A Signal 11 error is logged while trapped 
in an endless recursion in the 
libsm.so::pasymgetEx() function. 

After a user logs out, the RTE code will no 
longer try to access the global symbol table 
after it has been freed. 
 

QCCR1E84156 When you open, update, resolve, or close 
an Incident, warning message appears: 
Warning, indexing to NULL. The incident 
takes over 5 minutes to update. 

This issue occurs because the old 
implementation of the "copycurrent" RAD 
function did not copy a merged file 
properly.  This has been fixed in this 
solution. 
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QCCR1E84496 The system navigator is not displayed 
after login. 

Now, users can log in as expected. The 
system navigator is displayed correctly. 

 

Web Tier 

The following items are fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E48776 A list form shows fewer chart options in 
the web client than in the Windows client. 

All column fields in the list are now shown 
in the "Chart by field count" and "Chart by 
field value" menus. 

QCCR1E60097 When using characters that are treated as 
illegal (for example, the right-arrow 
character), the Web client fails with the 
following error message: "Error: The data 
%22Test"....is not legal for a JDOM 
character context: 0x1a is not a legal XML 
character." 

Control characters can be saved on the 
Windows and Web clients without errors. 
 
Note: If a control character is entered in a 
single-line text field of a record, then when 
Service Manager loads the record, the 
control character displays as "&#x…; " where 
"..." represents a hexadecimal number. For 
example, the right-arrow character will 
display as "&#x1a;". However, in a multi-line 
text field, the control character displays 
exactly as it was entered when the record is 
loaded. 

QCCR1E64004 Users get a 404 error in the Web client 
when they try to open or view attachments 
of multiple records. 

Now, users can open and view attachments 
of multiple records in the Web client. 

QCCR1E64183 There is no pop-up window to save the 
generated file when using Internet 
Explorer to generate an unload file. 
 
Note: This feature works correctly in 
FireFox. 

The issue was resolved by changing the 
messages used to generate the unload file 
from <xml> to <div> tags, so that IE can 
render the messages properly. 
 
Known issue in IE7 /IE8: 
The generated unload file will be blocked by 
IE with the default settings and the 
following message will be shown at the top of 
current page: 
 
"To help protect your security, Internet 
Explorer blocked this site from downloading 
files to your computer...." 
 
To avoid this known issue, perform the 
following steps to apply specific setting in 
IE7/IE8:  

1 Click Tools > Internet Options. 

2 Click the Security tab, and then 
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click Custom level.  

3 Scroll to the Downloads section of the 
list, and then, under "Automatic 
prompting for file downloads", 
click Enable. 

4 Click OK, click Yes to confirm that 
you want to make the change, and 
then click OK again. 

QCCR1E64306 The Web client hangs when running in 
Firefox 3.6. For example, after you choose 
a problem record from a record list and 
mark the problem closed, the record 
details pane is refreshed, but the record 
list becomes blank. The browser hangs 
until you terminate the browser session 
and log in again. 

The browser no longer hangs and the record 
list for a queue is displayed correctly after 
you update a record. 

QCCR1E64758 In Contributing Knowledge, after entering 
text in the HTML editors on the first and 
second pages of the notebook, a Validation 
Error popup may be displayed. If this 
occurs, the focus is set to the second (the 
previously focused) page, and the HTML 
editor on the first page is not displayed. 

The fckEditor iframe is now added to its 
container div correctly. As a result, the 
HTML editor with the text entered is 
displayed correctly now. 

QCCR1E66592 The web client does not honor the 
Justification properties defined in Forms 
Designer. 

The web client now honors the Justification 
properties defined in Forms Designer. 

QCCR1E67759 When a Timer widget that exists on a 
background tab (for example, the Incident 
queue screen) expires, the active tab (for 
example, the Incident detail screen) 
disappears and the timer on the 
background tab begins to count in the 
opposite direction. In addition, the 
background tab becomes unresponsive. 

The timer's data change event is now 
disabled when the tab is not active. 
Additionally, the timer now immediately 
submits the data change event if the user 
returns to this tab and the timer has 
expired. 

QCCR1E67762 In the Web client, HTML tags that are set 
as field values are compiled and therefore 
cause the QBE list to be improperly 
displayed. 

HTML formatted text in list columns are 
now treated as plain text instead of HTML 
elements. 

QCCR1E68676 The "Count Records" feature does not 
work. If using Internet Explorer, a 
JavaScript error is displayed in the left 
bottom corner of the browser. 

The "Count Records" feature works as 
expected and no JavaScript error occurs. 

QCCR1E69436 At lower resolutions, an unnecessary 
horizontal scroll bar appears in certain 
forms. 

This issue occurred because the expected 
sizes of widgets were too large. Now, control 
of the horizontal scroll bar is set as follows: 

Note: It is assumed that the screen 
resolution is not lower than 1024*768. 

• If the width of a detail form is smaller 
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than 500px, a horizontal scroll bar 
displays. 

• If the width of a detail form is larger 
than 500px, image widgets on the form 
will resize with the browser size. 
 

• Re-sizing of animated GIFs in Internet 
Explorer is not supported. 

 
• In some forms (for example, the System 

Status form “system.status.list.g”), you 
may find the text on some buttons are 
truncated if your monitor is set to a 
lower screen resolution. If so, re-design 
the form, and reduce the width of the list 
table on the right side. On the other 
hand, if the height of the table is too 
large, you may find that the horizontal 
scroll bar is missing; in this case you can 
move the vertical scroll bar to the bottom 
of the page so that the horizontal scroll 
bar appears, and you can also reduce the 
height of the table in Forms Designer. 

QCCR1E69798 The List Builder works differently in the 
Web client than when used in the 
Windows (desktop) client.  Specifically, the 
Web client cannot correctly save the values 
of List Builder.  

The List Builder now works correctly in both 
Web client and Windows client. 
  

QCCR1E70032 When trying to perform 'Count' in the web 
client with recordlist enabled and a special 
character contained within the first 
column of the QBE, the count returns “0 to 
0 of 0.” 

The count returns the correct number when 
the user clicks the Count button in the Web 
client. 

QCCR1E70206 An error occurs when you perform a 
"Count Records" operation in a QBE in a 
Web client that is running on Internet 
Explorer. This issue occurs if the database 
is configured with a 
Cyrillic_General_CI_AS collation and the 
query contains Russian characters. 

The "Count Records" feature now works as 
expected. 

QCCR1E71421 The "Export to Excel/ Export to text" 
option does not work in the Web client 
(using Internet Explorer) when there is a 
marquee.  The 'Your file had been exported 
successfully' message displays, but no file 
is saved and there is no dialog prompt to 
save or download file. 

When there is a marquee in the form, the 
"Export to Excel/ Export to text" option now 
works correctly on both Internet 
Explorer and Firefox.  
  

QCCR1E71677 As users open more QBE lists in the web 
client, the size of the "Tablexx" cookie may 
increase to exceed the limit. 

Now, data that was previously stored in the 
cookie is now saved in session storage. 
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QCCR1E72291 Result of the Count Records button is not 
correct when you click on the next button 
(>) button. For example, in a table of 468 
records, the Count of the records may 
display "301 to 350 / 1931" instead of "301 
to 350 / 468" 

The result of the Count Records button is 
now displayed correctly. 

QCCR1E72468 The Dynamic View Dependency for 
checkbox controls is evaluated incorrectly 
in the Web client. For example, if you set 
the "Selected Condition" property to a 
variable that evaluates to false, the check 
box is unchecked in the Windows client but 
checked in the Web client. 

The Dynamic View Dependency for checkbox 
controls is evaluated correctly in the Web 
client. 
 
  

QCCR1E72743 The Web client ignores the "Invisible" 
settings in the fields of the "Data policy" 
table. 

The Web client no longer ignores the 
"Invisible" settings in the fields of the "Data 
policy" table.  

QCCR1E73103 Some users are unexpectedly logged out 
from the Web client when the number of 
cookies exceeds the limit specified by 
Internet Explorer. 

The issue is fixed by reducing the number of 
cookies used by the Web client. 

QCCR1E73982 When trusted sign-on is enabled, the Web 
client uses the language specified in the 
operator record, instead of "lang" 
parameter passed in by the Ess.do url. 

For Web client, in WEB-INF/web.xml, a new 
servlet parameter, acceptBrowserLang, was 
added. 
 
By default, this value is true. If this value is 
true, the Web client will take the browser's 
language setting as the first priority in TSO 
mode. If the value is set to false, the Web 
client will use the language setting in the 
operator's profile. 
 
Note: If the "lang" parameter is set in the 
URL, it will take precedence over the 
acceptBrowserLang parameter. 
 
See acceptBrowserLang. 

QCCR1E74013 By default, the MaxFileSize value of 
log4j.appender.R is only 100K. This value 
should be increased. 

Now by default, the maximum file size for 
sm web client log "sm.log" is increased to 
5000K and up to 10 rolling files can be kept. 

QCCR1E75369 In a low screen resolution (for example, 
1024*768), some buttons in the System 
Status panel overlap the table on the right 
and appear incomplete. 

Buttons in the System Status panel now no 
longer overlap the table on the right.  
 
However, in a low screen resolution, the text 
on the button may be truncated if it is too 
long. To avoid this, you can re-design the 
System Status form and reduce the width of 
the table so that the text on the button can 
be displayed completely. 
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QCCR1E75391 In a Web tier form, a changed field retains 
the old value after the form is saved and 
then re-opened, and then the field is 
cleared and replaced by a space character. 

The changed field no longer reverts to the 
original value when saved. 
 
  

QCCR1E76036 You cannot delete data in a ComFill object 
by using the backspace key when the 
'select only' property is enabled. 

You can delete data in a ComFill object by 
using the backspace key when the 'select 
only' property is enabled. 

QCCR1E76361 In Internet Explorer (IE) 7 (or the 
compatibility view of IE8 and IE9), after 
users select the "Chart by ..." menu from a 
QBE list and then close the Chart page to 
return to the QBE list, the menu shadow 
does not disappear and the tab page 
becomes unresponsive. 

The "Chart by ..." menu now works fine; 
after the menu is hidden, the shadow 
disappears as expected and the tab page is 
responsive. 

Limitation: In the QBE list, clicking a cell 
under the original menu shadow does not 
select the row; however users can select the 
row in either of the ways: 

• Select the row by clicking a cell that was 
not under the menu shadow. 

• Show the menu again, hide the menu by 
clicking anywhere else, and then select 
the row by clicking on any cell in the 
row. 

QCCR1E76542 The JSP compiler in some later Web 
application servers (e.g. Tomcat 7 as 
opposed to Tomcat 6), enforces types more 
strictly when compiling Java code. 
Therefore, some older JSP code cannot be 
compiled, and prevents the Service 
Manager Web tier from displaying the 
login page. 

The SM login page can be correctly displayed 
after upgrading the Web application server. 

QCCR1E76628 When a form is refreshed, the cursor is 
returned to the first tab regardless of its 
initial position. 

Now, when the user selects a tab on the 
client side, the notebook state is saved and is 
then restored when the form is refreshed. 

QCCR1E76793 If users are kicked off from the Service 
Manager (for example, by the inactivity 
timer), they cannot continue to operate in 
BSM 9.12. 

The LW-SSO token is no longer cleared 
when users are kicked off from the Service 
Manager, so users can continue to operate in 
other applications with LW-SSO enabled. 

QCCR1E77415 When a record contains special characters 
in a multi-line text field, the Web client 
converts the characters into their HTML 
code representations in Print Preview. 
For example, quotation marks are replaced 
by &quot, and a greater than sign (>) by 
&gt. 

Print Preview can display special 
characters correctly. 
  

QCCR1E77454 By default, the mask is always grey. If the 
mask were transparent, it would avoid the 
appearance of poor performance. 

The default mask is now transparent. In 
addition, a new web.xml parameter 
maskMessageDelay is introduced to specify 
the number of seconds that should elapse 
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before the loading message on the mask is 
displayed. Note that if a value greater than 
15 is specified for the maskMessageDelay 
parameter, the loading message displays 15 
seconds later anyway if a JavaScript error 
caused hang issue has been detected. 
See maskMessageDelay. 

QCCR1E78076 Records cannot be displayed by using the 
Find function on a read-only field in the 
Web tier. When this issue occurs, the user 
receives the following message: 
 
"No link exists for this field, find 
function cannot be performed." 

The Web tier can find the related 
information when the field is read-only. 
 
  

QCCR1E78176 When you set the main menu to SC style 
after you log in, a JavaScript error is 
received. Additionally, groups cannot be 
expanded automatically. 

There is no JavaScript error in the main 
menu page, and the first group is expanded 
by default. 
 

QCCR1E78433 The magnify function in the Web tier no 
longer works correctly after applying 
Service Manager 9.21 patch 5 Web tier. 

Content in the magnify dialog can be shown 
now. 

QCCR1E79109 Web client images are not displayed at the 
correct size when forms are first rendered 
in the Web client. 

Images are rendered at the appropriate size 
in the Web client. 
 

QCCR1E79840 No results are returned when using MySM 
with non-English characters defined in a 
RAD Query. 

The correct records are returned. 

QCCR1E80228 Users cannot see the graphical relations 
about CI's in the Service Manager Web 
client when the web application server's 
context path is of a multi-level structure, 
such as "/sm/sm921". Instead, the graph is 
always empty. 

Users can now see the graphical relations 
about CI's in the Service Manager Web 
client. 

Known issue: 
If the web application server's context path 
is of a multi-level structure, such as 
"/sm/sm921", MySM pages cannot be 
displayed and an error occurs. To resolve 
this issue, perform the steps below to update 
the records in the "uimcompdefinitions" 
table: 

1 In Database Manager, type 
"uimcompdefinitions" in the Table field, 
and click Search. 

2 Click Search to retrieve a list of records 
in the "uimcompdefinitions" table. 

3 For all the records, add the additional 
context path as a prefix to the "View Url" 
and "Filter Url" fields. For example, if 
the custom context path is "/sm/sm921" 
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Global ID Problem  Solution  

and the value of the "View Url" field is 
something like 
"/uimComponent.jsp?ctx=chart&…", 
change the value to 
"/sm921/uimComponent.jsp?ctx=chart&
…". 

4 Save the records. 

5 Log off Service Manager and log back in 
for the changes to take effect. 

QCCR1E88461 In the ESS client, a 404 error occurs when 
the user attempts to open an attachment. 

In the ESS client, now you can open an 
attachment successfully without any errors. 

Windows Client  

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E57462 Cannot mass update incidents, as an 
"Unrecoverable Error refreshing screen" 
occurred in the Windows client. 

Mass Update and Mass Close operations can 
be executed without triggering the exception 
now. 

QCCR1E73271 The display event (record lock) fires 
properly on the first update of a record but 
then fails on subsequent updates to the 
same displayed record. When the user 
enters additional updates, a message is 
received that indicates the record is 
currently locked by another user and the 
current changes are lost. 

Reset the flag to initial value when user 
updates the record. 

QCCR1E73687 When scrolling through documents in the 
Knowledge Management Pending 
Documents Queue, the Pending 
Documents list freezes after you select 
documents several times. The selected 
document does not load, and the Pending 
Documents list remains frozen 
indefinitely. The issue occurs when Record 
List is turned on. Additionally, an error 
message appears when you click the Next 
or Previous buttons. 

The Pending Documents list no longer freezes 
after you select documents several times, and 
the selected document is loaded correctly. 
When you click the Next or Previous button, 
no error messages appear. 

QCCR1E73743 When a groupby clause is specified, an SM 
process may attempt to fetch all the 
records from the database. 

When a groupby clause is used, only the last 
group is retrieved.  
 
Note: All rows are fetched only when no 
groupby clause is specified. 

QCCR1E76628 When a form is refreshed, the cursor is 
returned to the first tab regardless of its 

Now, when the user selects a tab on the client 
side, the notebook state is saved and is then 
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Global ID Problem  Solution  

initial position. restored when the form is refreshed. 

Applications 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E71099 Users need to display Value Lists 
instead of the data directly retrieved 
from the database in a QBE list when 
adding a field by using Modify 
Columns. 

Value Lists can be displayed instead of the 
data directly retrieved from the database in 
a QBE list when adding a field by using 
Modify Columns. To achieve this, it requires 
both the current patch release and 
the corresponding unload file. 
For the unload file, see New Application 
Updates in the Current Patch. 

Documentation 

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E76433 Particular error pages are only 
displayed in the WebSphere log but not 
in the browser. For example, the "The 
session is busy, please try again later" 
message that occurs when the 
lockWaitTimeOut setting is exceeded.  
  
This is caused by a WebSphere 
problem ("An error code always returns 
even though there is a matching error 
exception type defined in web.xml.") 

Created knowledge article KM1449176 
(http://support.openview.hp.com/selfsolve/d
ocument/KM1449176), which provides the 
steps to add a Web container custom 
property setting when deploying the Web 
tier on WebSphere 6 or later. 
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Global ID Problem Solution 

QCCR1E78706 After Service Manager (SM) was last 
recycled (using SM 9.21 patch 5 RTE), 
sometimes accessing an SM WSDL can 
cause a signal 11 error. Also, SM is not 
processing any web services 
transactions.  
This is because of an Oracle bug 
("Multi-Threaded OCI Client Dumps 
Core after Reconnecting To Database"), 
which exists on Oracle 11.1 and above 
and is triggered when ADR tracing is 
enabled. Once this bug is triggered, the 
SM server will crash every time when 
setting up a connection to the Oracle 
Server. 

Use the following information to 
supplement the HP Service Manager 
Installation Guide when setting up 
connectivity to your Oracle database:   
For Oracle 11.1 or above only, disable ADR 
tracing by turning off the diag_adr_enabled 
parameter in the sqlnet.ora file:  
diag_adr_enabled=OFF 
(By default, ADR tracing is enabled.) 
 

Note: An Oracle bug ("Multi Threaded OCI 
Client Dumps Core After Reconnecting To 
Database") is triggered when ADR tracing 
is enabled. Once this bug is triggered, the 
Service Manager server will crash every 
time when setting up a connection to the 
Oracle server.  
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Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E88002 The "serverHost=null&serverPort=null" 
parameters are included in the Web tier 
URL when clicking the "Login again" link. 
Login fails with the error message displayed 
on the Login page: 
Service Manager Server is currently 
not available, please try again later. 

Remove "serverHost=null&serverPort=null" 
in the URL manually so that you can log in 
successfully. 
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Installation Notes 

Digital Signature Notice 

HP signs Windows executable files with a digital signature. This process has been updated to use a new 
VeriSign root certificate. On a Windows system that does not have the new VeriSign root or intermediate 
certificate installed, when the user right-clicks the file and then goes to Properties > Digital Signatures > 
Details, a verification error will display: “The certificate in this signature cannot be verified.”   

 

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140 

Web Tier Installation 

Important Note:  The Service Manager introduces important changes to the Web tier Directory structure 
since SM 9.21 Patch 5 release.  For more information on these changes, see the release notes of SM 9.21 
Patch 5 and the “Updates to the Service Manager Web Tier Directory Structure” white paper at the 
HP Software support Web site: 

www.hp.com/go/hpsoftwaresupport 

https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
http://www.hp.com/go/hpsoftwaresupport
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The Web Tier update consists of a compressed file, sm9.21.551-P6_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a new 
installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 
save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 
your webtier-9.21.war (.ear) file. 

2 Delete or uninstall the existing webtier-9.21.war (.ear) file. 

3 Deploy the new webtier-9.21.war (.ear) file by following the instructions in the Service Manager 
Installation Guide. 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. 
Note: Be sure to set the securelogin and sslport parameters. 

6 Restart the Application server. 

Windows Client Installation 

The Windows client update consists of a compressed file, sm9.21.551-P6_Windows_Client.zip, which 
contains setup.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 
guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client.  
The client should be Release: 9.21.551. 

Server Installation 

The server update for your operating system (OS) consists of a compressed file, sm9.21.551-P6_<OS>.zip  
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 
Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

Important: This server update includes an upgrade of the embedded Tomcat to version 6.0.35. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 
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4 Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.35 when you 
extract the server files later.  

5 Delete the RUN/lib directory.  

6 Extract the compressed files for your operating system into the main Service Manager directory on the 
server. The default path is:  C:\Program Files\HP\Service Manager 9.21. 

7 For UNIX servers, set the file permissions for all Service Manager files to 755. 

8 If you have made any customizations or changes to the original RUN/tomcat folder, restore them in the 
new RUN/tomcat folder. 

9 Make sure the server is stopped, and run the "sm -unlockdatabase" command. 

The purpose of this step is to prevent stale license information from being kept in the system. In a 
scaling implementation, you can run this command from any one of your servers. 

Note: This step is required the first time you upgrade to 9.21P6; it is also required whenever you change 
the server’s IP address after the upgrade. 

10 Restart the Service Manager server. 

11 Restart the Service Manager clients. 

12 Check the version in Help > About Service Manager Server.  
The server should be Release: 9.21.551. 

Application Unload Installation 

The application consists of the unload files that come with the server updates. When you extract 
sm9.21.551-P6_<OS>.zip (or .tar), it will add the new files to your  
[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory. 

Unload File Naming Convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

• <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 

• SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 
and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

• SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If this suffix is omitted, the unload file is then intended for all applications versions compatible 
with the server version. For example, for Service Manager server 9.21, the compatible applications 
versions are 7.11 and 9.20. 
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New Application Updates in the Current Patch 

There are following new application updates are included in this release: 

Unload file Used for applications 
version(s) 

Description  

QCCR1E71099_SM921P6_SM711.unl 7.11 Enables the Value Lists to be 
displayed instead of the data directly 
retrieved from the database in a QBE 
list when adding a field by using 
Modify Columns.   

 

QCCR1E71099_SM921P6_SM920.unl 9.20 Enables the Value Lists to be 
displayed instead of the data directly 
retrieved from the database in a QBE 
list when adding a field by using 
Modify Columns.   

 

Application Updates in Previous Patches 

Important Note:  The unload files must be loaded in order of patch.  That is, all Patch 1 unload files must 
be loaded before any Patch 2 unload file is loaded and so on for Patch 3, Patch 4, etc...  However, the order in 
which you load the unload files for Patch 1 does not matter. 

Additional application updates have been included with this cumulative release. If you have not already 
applied them for a previous patch, you should also apply the unload files that are used for your applications 
version (see the following table). For more details about these applications updates, see the Release Notes for 
those patches, also included with the release. 

Unload file Introduced 
in 9.21 patch 

Used for 
applications 
version(s) 

Description  

QCCR1E55715_SM921p1.unl 
 

P1 7.11 and 9.20 Includes application changes to 
reduce database I/O on login. 
 

 

QCCR1E57767_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 
reduce jgroups traffic on login. 
 

 

QCCR1E59753_SM921p2.unl P2 7.11 and 9.20 Includes application changes to 
fix the ToDo bar.  
 

 

QCCR1E31545_SM921P2_SM711.unl P2 7.11 Prevents backslashes included 
in a template from being 
duplicated in the output. 

Note:  This file is not required 
for Applications 7.00. 

 

QCCR1E31545_SM921P2_SM920.unl P2 9.20 Prevents backslashes included 
in a template from being 
duplicated in the output. 
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Unload file Introduced 
in 9.21 patch 

Used for 
applications 
version(s) 

Description  

QCCR1E49721_SM921P3_SM711.unl P3 7.11 Enables translation of 
Display/Value lists on dynamic 
forms. This is a required fix for 
the Export to Excel redesign. 

 

QCCR1E56678_SM921P3_SM711.unl P3 7.11 Lists the records in the right 
group order when a record list 
is refreshed. 

 

QCCR1E58562_SM921P3_SM711.unl P3 7.11 Includes applications changes 
for Export to Excel redesign. 

 

QCCR1E58562_SM921P3_SM920.unl P3 9.20 Includes applications changes 
for Export to Excel redesign. 

 

QCCR1E67610_SM921P4.unl P4 7.11 and 9.20 Enables you to block 
potentially dangerous 
attachments. 

 

QCCR1E67072_SM921P4.unl P4 7.11 and 9.20 Enables you to improve the 
Knowledge Management 
update process (KMUpdate) 
performance. 

 

QCCR1E67647_SM921P5.unl P5 7.11 and 9.20 Updated the scmessage record 
from "Doc Engine call failed” to 
include the message number.  

 

QCCR1E70163_SM921P5_SM711.unl P5 7.11 Prevents the KMUpdate 
process from terminating when 
the Search Engine server is 
shut down or an indexing 
document error occurs. 

 

QCCR1E70163_SM921P5_SM920.unl P5 9.20 Prevents the KMUpdate 
process from terminating when 
the Search Engine server is 
shut down or an indexing 
document error occurs. 
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To load an unload file: 

1 Make sure the Windows client is configured for server-side load/unload.  

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Unselect Client Side Load/Unload if is flagged.  

c) Restart the Windows client. 

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  
All Messages 

Select this option to see all messages that Service Manager generates loading the 
file. 

Messages Option —  
Totals Only 

Select this option to see only the total number of files Service Manager loads. 

Messages Option — 
None 

Select this option to hide all messages that Service Manager generates when 
loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  

 

ODBC Driver Update Installation 

The ODBC Driver update consists of the sm9.21.551-P6_ODBC.zip file, which contains the following 
updated files: 

• Scodbc32.dll 
• sci18n.dll 
• sccl32.dll 

To install the ODBC Driver update: 

1 Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine 
Systems\ServiceCenter 6.2\ODBC Driver. 

2 When prompted, replace the three old DLL files with the new ones. 
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Back-out Instructions 

If you want to restore your Service Manager system to its original state after installing Service Manager 
9.21, follow these guidelines. 

Server 

Before applying the server patch, make a backup of the server installation folder. For example, C:\Program 
Files\HP\Service Manager x.xx\Server. 

To roll back your server to its original state, remove the existing server installation folder and copy the old 
one back. 

Applications 

When loading an unload file 

Before loading an unload file, perform the following steps to make a backup of the files to be modified by the 
unload file: 

1 Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to 
the unload file. 

2 Click List Contents on the menu bar, to view a list of files that have been updated in this unload. 

3 Go to Tailoring > RAD Editor, search for the files you got in step 2, and click More > Export/Unload.  

4 In the popup window, specify your backup upload file path/name, and click Unload Appl.  

Note: Make sure that Append to file is selected. 

When applying an application patch 

Before applying an application patch, make a backup of your database. To roll back your application 
changes, restore your database to the backup. 

Web Tier 

Before deploying the new web tier, back up your web.xml file, application-context.xml, splash screen, 
style sheets, and any other customizations you made, including your webtier-9.21.war (webtier-ear-
9.21.ear) file.  

To roll back to the old web tier: 

1 Delete or uninstall the existing web tier. 

2 Redeploy the old web tier. 

3 Restore your old customizations.  
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Windows Client 

You can only uninstall the new Windows client, and then reinstall the old one. 
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Addition to the Documentation 

The following information supports updates included in this patch. 

• Deploy the Service Manager Web Tier on WebSphere 8.0 

• Deploy the Service Manager Web Tier on JBoss 5.1 

• JavaScript global method: doHTTPRequest 

Deploy the Service Manager Web Tier on WebSphere 8.0 

WebSphere 8.0 is supported in this release. To deploy the web tier on WAS 8.0, perform the following steps.  

Note: The  “x.xx” in the steps represents the Service Manager version, that is, 9.21.  

1 Copy or save the webtier-x.xx.ear file onto your local system.  

2 Update the webtier-x.xx.ear file by modifying the web.xml file contained in the webtier-x.xx.war file 
(which is packaged in the ear file). At a minimum, you need to set four parameters in the web.xml file: 
serverHost, serverPort, secureLogin, and sslPort.  

Note: By default, the HTTPS port used by IBM WebSphere is 9443, which is different from the default 
sslPort (8443) defined in the web.xml file. Be sure to either change the HTTPS port in IBM WebSphere 
or modify the sslPort in the web.xml file to make them consistent. 

3 Re-archive the files in the ear file. Be sure to keep the original filenames and folder structure. 

4 Log on to the administration console of the WebSphere 8.0 Application Server with system privileges.  

5 Click Applications > New Application, and then select New Enterprise Application.  

6 Select Local file system and browse to your updated webtier-x.xx.ear file.  

7 Click Next. The file uploading starts. This may take quite a while. 

8 Click Next on each screen to accept the default settings until you reach the final step, and then click 
Finish. The installation of the web tier ear file begins. Wait until the installation completes.  

9 Click Save to save your configurations. 

10 Go to Applications > Application Types > WebSphere enterprise applications > HP Service Manager 
x.xx Web > Class loading and update detection, and make the following selections:  

- In the "Class loader order" section, select Classes loaded with local class loader first (parent 
last).  

- In the "WAR class loader policy" section, select Single class loader for application. 

11 Go to Applications > Application Types > WebSphere enterprise applications > HP Service Manager 
x.xx Web > Manage Modules, and do the following: 

a Click HP Service Manager in the Module column. 

b In the "Class loader order" section, select Classes loaded with local class loader first (parent last).  

12 Click Save to save your local configuration changes. 

13 Go to Applications > Application Types > WebSphere enterprise applications, and start the “HP 
Service Manager x.xx Web” application.  

14 When the application is successfully started, you can browse to the web tier login URL to launch the web 
client: http://<WAS_server_hostname>:<port>/webtier-x.xx/index.do 
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Deploy the Service Manager Web Tier on JBoss 5.1 

The following example describes how to deploy the web tier .war file or .ear file on JBoss 5.1. 

 

To deploy using the web tier .war file: 

1 Install JDK 1.5x from the Oracle web site. 

2 Set the JAVA_HOME environment variable to the location of the JDK 1.5x version you installed in step 
1. 

3 Download the JBoss binary version from the JBoss website. 

4 Extract the JBoss package to a folder. 

5 Add the JBOSS_HOME environment variable and set it to the location of the path above. 

6 Before deploying the web tier .war file, extract the war file into a temporary folder. 

7 Make necessary changes to the web.xml. For example, set the following parameters: secureLogin, 
sslPort, serverHost, and serverPort. 

8 Zip the extracted .war file and rename it back to .war file. 

9 Copy the modified .war file to: %JBOSS_HOME%\server\default\deploy. 

10 Start JBoss manually if you did not set JBoss as a service from %JBOSS_HOME%\bin (by clicking 
run.bat). 

Note: To stop JBoss manually, navigate to the %JBOSS_HOME%\bin directory and issue the 
shutdown -S command. 

11 Launch the web client URL to test the connection. 

Note: By default, JBoss listens on port 8080. If this port is already in use on your machine, change the 
HTTP Connector port in the JBoss server.xml file and restart the JBoss application server. 

Example: http://localhost:8080/webtier-9.21/index.do 

 

To deploy using the web tier .ear file: 

1 Extract the .ear file to a temporary folder. 

2 In that folder, modify the web.xml file in the .war file as described above. 

3 Delete the endorsed directory. 

4 Zip the extracted .ear file and rename it back to the .ear file. 

5 Copy the modified .ear file to the following directory: %JBOSS_HOME%\server\default\deploy. 

6 Start JBoss manually if you did not set JBoss as a service from %JBOSS_HOME%\bin (by clicking 
run.bat). 

Note: To stop JBoss manually, navigate to the %JBOSS_HOME%\bin directory and issue the 
shutdown -S command. 

7 Launch the web client URL to test the connection. 

Note: By default, JBoss listens on port 8080. If this port is already in use on the JBoss application 
server host machine, change the HTTP Connector port in the JBoss server.xml file and restart the JBoss 
application server. 

Example: http://localhost:8080/webtier-9.21/index.do 

http://localhost:8080/webtier-9.21/index.do
http://localhost:8080/webtier-9.21/index.do
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Note: When deploying Service Manager web tier on JBoss 5.1.x on the AIX platform, if  exceptions like 
“java.lang.ClassNotFoundException: com.sun.org.apache.xerces.internal.dom.DocumentImpl” occur, you need 
to manually copy two jar files (jaxp-api-1.4.3.jar and jaxp-ri-1.4.3.jar) into the 
%JBOSS_HOME%/lib/endorsed directory. These two jar files can be found under the ./endorsed directory in 
the web tier .ear file. 

JavaScript global method: doHTTPRequest 

The following is an additional note for the JavaScript global method doHTTPRequest, which sends an HTTP 
request to a remote server. 

Note: If the charset is not defined in the “Content-Type” header in the parameter “Headers”, the charset for 
the message body will be UTF-8 by default.  

For more information about the doHTTPRequest parameter, see Service Manager help. 
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) web page:  
http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 
www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valued support 
customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 
http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 
http://h20229.www2.hp.com/passport-registration.html 

http://support.openview.hp.com/sc/support_matrices.jsp
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notice 

© Copyright 1994-2012 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

• Adobe™ is a trademark of Adobe Systems Incorporated. 

• Java™ is a registered trademark of Oracle and/or its affiliates. 

• Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. 

• Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

• UNIX® is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 
web site and search for the product manual called HP Service Manager Open Source and Third Party 
License Agreements. 
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